PRINT & CUT
PERFECTION
Four lessons to help you
master Print & Cut
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Introduction
Welcome! In this eBook you’ll learn all about the
Print & Cut feature for your Silhouette machine.
Print & Cut is one of the most basic but versatile
features of any Silhouette cutting machine.
Print & Cut allows you to print an image from the
Silhouette Studio® software on your home printer.
Then your Silhouette machine cuts precisely
around that printed image.
In this eBook we’ll show you some examples of
printable media you can cut with your machine,
what elements you need on your document for
the Print & Cut process to happen successfully,
and how to open or create those designs to
prepare them for Print & Cut. We’ll go through
a few projects so you can see how easy and fun
this can be!
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Tools and Supplies:
f Silhouette Cameo®, Silhouette Portrait®, or
Silhouette Curio™. Each of these machines
is capable of Print & Cut.
f Printer. Most Silhouette printable materials
use an inkjet printer.
f Printable media. This can be paper or one of
many other kids of printable media available
from Silhouette. This includes things like:
• Wide variety of sticker paper (clear,
white, metallic foil, glow-in-the-dark,
printable scratch off, glitter, kraft,
holographic, etc.)
• Printable adhesive cardstock
• Printable vinyl
• Printable heat transfer
• Temporary tattoo paper (white or clear)
• Printable magnet paper
• Printable cotton fabric
• Shrink plastic (white or clear)

f Spatula tool to help remove
cutouts from mat
f AutoBlade or Ratchet blade, depending on
your machine and personal preference
All of the features we’ll use work in the standard
edition of Silhouette Studio®. You’ll need to work
with version 4.2 or higher for access to all the Print
& Cut features, such as Print Bleed, in this eBook.
The examples shown use Silhouette Studio®
version 4.3.
Now that you know what you need, let’s get
started with some Print & Cut designs.
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How To:
Click the Store tab in Silhouette Studio®. In version
4.2 and higher, this opens a new browser window.
Let’s suppose you want to find a printable birthday
design so you can make a card.

Go to Designs > Celebrations > Birthday. You
could also type “birthday” in the search field to do
a keyword search.

Lesson 1: Printing & Cutting Designs
The easiest Print & Cut project is one that’s already designated as a Print & Cut design in the Silhouette
Design Store, so that’s where we’ll start.
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Once you have some results, simply add the filter
for Print & Cut, and now you’re only looking at
Print & Cut designs!

If it’s not a Print & Cut design but you want to
make the design a printable design, that’s OK
because we’ll show you how to do that later.

Go to File Types, deselect all, and only check Print
& Cut. Now any design you see here is ready to be
printed and then cut.

You can also filter designs in your
Silhouette Studio® Library for Print & Cut files.
Let’s go to the Library tab, and we’ll look in this
folder for Flowers. There are a lot of designs here,
but we only want to see Print & Cut designs.

Notice the P-icon that shows it’s a Print & Cut
file, so as you’re browsing through designs in the
Design Store, you know that’s a Print & Cut file. If
you’re looking at a Print & Cut design’s details, the
design type will say “Print & Cut.”

Let’s open a watercolor flower as an example,
and you’ll see how easy it is to use a Print &
Cut design. Open by double-clicking the library
thumbnail image.
Note: Remember to turn on all the library filters
again with “Select All” before searching for
other file types.
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As we look at this flower, let’s talk about the four
basic elements you need for every Print & Cut
design to work:

Second, your design needs color, even if the only
color is black. This floral design has color, so we’re
good for this one.

1.	 The page size of the Silhouette Studio®
document must match the media size
you print on.
2.	 The design needs color.
3.	 The design needs cut lines.
4.	 Registration marks must be enabled.

Third, your design needs cut lines so that the
Silhouette machine knows where to cut. You can
see the red cut line on this design. Default cut
lines (those that are set at only 0.0 thickness) do
not print.

First, make sure the page size on your Studio
document matches the media size you’ll be
running through your printer. For Silhouette’s
printable media, that’s letter size. Set that in the
Page Setup panel.

Finally, you need registration marks turned on for
your Print & Cut to work. You can use the hotkey
letter M for “mark.”

You can see the line thickness in the Quick Access
Toolbar or in the Line Style panel.

We’ll talk more about registration marks in a
minute, but let’s look at another example first.
Open “Shadow Box Card Scene – Fall Bird.” You
can see it’s got some pieces that could be cut with
colored paper, but it has some multicolored pieces
that are definitely meant to be printed.
This red line is visible in the software only and
won’t print unless you choose to thicken the cut
line above 0.0 or check the box on the Line Style
panel to “Print Lines of Selected Shapes.”
Resize a design smaller, if necessary, by dragging a
corner handle so it fits on the page.

Choosing a Print & Cut file from the Design Store
automatically ensures the color and cut lines of
a design, and that’s why that file type is a nice
design choice.

Print & Cut Perfection7

Ungroup and move the solid pieces off to the side.
You can cut those individually from cardstock or
patterned paper that’s similar to those colors.
Now we have our designs to Print & Cut. Move
these closer together on the virtual paper.

Go to the third tab of the Page Setup panel or
use the hotkey letter M to turn on registration
marks. If you go into the registration mark tab,
you can see you’ve got choices for On or Off in
Silhouette Studio® v 4.3 and higher.

Those marks tell your machine where your cut
lines are in relation to those marks, so it can
compensate for things like the differences in how
you load your media and mat each time.

Remember the four elements you need to check
before printing and cutting.
1.	 The page size is “letter” to match the paper
we’ll be printing on.
2.	 The designs have color.
3.	 The designs have cut lines.
4.	 The registration marks are turned on.
We still need to turn on the registration marks, so
let’s talk about them a little more in depth.

In the software you’ll see a black square in one
corner, and corner lines in two of the other
corners. Those are the marks that will print so
your machine can use its optical eye to read those
marks on the printout.

Note: Older versions of Silhouette Studio®
present registration mark choices of “Off,”
“Type 1,” or “Type 2.” Most users need Type 1,
which is for any model of Cameo, Portrait, or
Curio. Type 2 is for the oldest machine models
that preceded the Cameo.
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The crosshatch area is the area where you need
to avoid placing your designs. As the machine
moves to each registration mark, it shouldn’t have
anything in the crosshatch area because that could
confuse the optical eye.

Finally, you can see there’s a red cut border on
the page. If you don’t see it, make sure to check
the box for Show Cut Border on the first tab of
the Page Setup panel. Your machine will not cut
outside the cut border, so your designs need
to be inside the red cut border as well as the
crosshatch areas.

Position the pieces close together inside the red
cut border while avoiding the crosshatch areas.

The crosshatches only show in the software. They
do not print.

This is optional, but in the Registration Marks tab,
you can adjust the length, thickness, inset, and
orientation of your marks.
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In the Advanced Options, you can manually adjust
the insets to conserve paper or to make your
designs fit better. We’ve rearranged the designs in
this example to fit the smaller space.

Now let’s check the cut lines and settings in the
Send panel. This shows us a preview of our cut
lines. If the bold red lines are where we expect
them to be, that’s good, and we’re ready to print.

Select your printer and click on Preferences to
make sure the document is set up the way it
needs to be.
Your printer dialog box may look different from
this; what it looks like depends on your printer.
Look to make sure the paper size is the same
(letter) and the orientation is the same (portrait)
as in your Silhouette Studio® document.

We’ll print this example on white cardstock.
Just keep in mind that the default length and
thickness provides the most accuracy. If your cuts
are off or not being read, click “Restore Defaults,”
and then reposition the objects on your page
to stay within the red cut border and out of the
crosshatch areas.

To print, you can do this from the Send Tab or from
the main Design Tab. Use File > Print or click on
the Printer icon.

You might want to adjust to higher-quality print
settings or tell the printer to feed material from the
back instead of the paper cassette, depending on
what works best for that material and your printer.
You might also choose to do a print preview if you
want to see how the design will look before you
commit it to print.
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Accept any changes, and click Print.
The document will go to your selected printer.
It’s important that you do not move or alter
the design in Silhouette Studio® once it has
been printed.
Notice the cut lines do not print unless you make
them larger than the default 0.0 thickness.
In the Send tab, choose the following:

The machine will read the registration marks
before cutting when you have registration marks
turned on in the document.
Once the reading is successful, the Silhouette
machine moves immediately into cutting
the design.
Attach the Print & Cut elements to the assembled
plain card pieces with adhesive foam dots or
another paper adhesive.

f Material = Patterned paper (or any printable
media you’re using)
f Action = Cut
f Tool = AutoBlade (or other blade choice)
Load the printout on your mat exactly as you see
on screen with the black square in upper left grid
corner, and click Send when you’re ready.
The watercolor flower and the printable card
pieces were examples of designs that are already
in the Design Store as Print & Cut files. All the
elements are there to open the design, print it,
and cut it.

Print & Cut Perfection11

For example, look at this bunny.

As we’ll show you in a minute, this design comes
in several uncolored pieces when you open it
in Silhouette Studio®. If you cut it from various
colors of paper, it requires assembly by gluing
all those pieces together. That’s great if you like
paper piecing and if you’ve got the right colors of
paper to use.

Lesson 2: Converting Regular Files to Print & Cut Files
In this lesson, we’ll show you how to convert cut files into Print & Cut designs. You might be wondering
why you would choose to Print & Cut instead of performing a regular cut.
This method is good for when there’s a design in your library that you’d like to print but the design opens
with many colorless pieces spread across the design space.

But if you don’t like spending the time with a lot of
assembly and you want to make multiples of this
design, then Print & Cut may be a better option
for you. You can also choose patterns or custom
colors in the software to get just the right look.
You might also want to make the design really
small, and a Print & Cut is easier to work with. This
way, you’re working with a printable, color-filled
image on your page instead of a bunch of tiny cutout pieces that may be difficult to put together.
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With a cut file, it’s personal preference whether
you cut it in layers from various materials or if you
choose to convert it into a Print & Cut file. We’ll
show you how to do that now, so you’ll have the
option to do it either way.

Open the Fill panel to color the different pieces.
Every design is different, so you may need to
group and ungroup different parts as you go.

Notice the nose and mouth area on this design is a
cutout, which means it’s a compound path. We’ll
revisit that shortly.
Line colors at their default 0.0 thickness do not
print. Any time the lines are thicker, that’s when
the line color will show. When making a Print &
Cut, you may find the red cut lines distracting, so
you can set them to invisible with the Line Color
options even though they won’t print.

How-to:
Open the “Bunny Sunglasses” design and
then Ungroup it. See how this file is a bunch of
uncolored pieces on the page?

Select one or multiple pieces as you choose
colors from the Fill panel. Hold Shift while clicking
on multiple shapes to select them at the same
time. There are three tabs on the Fill panel: Solid,
Gradient, and Pattern.

It’s like this so we can cut out the pieces with
various layers of paper and then assemble the
pieces together. That’s a fun way to do it, but we’ll
use this as an example so you know how to turn
any design like this into a Print & Cut design.

Drag everything into position. Group objects
together (Ctrl + G or Cmd + G), send to front or
back, zoom in, and use your keyboard arrow keys
to nudge as necessary. You’ll find many of these
commands conveniently placed on the Quick
Access Toolbar.
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Now that the design is colored and arranged,
we’ve resized this and made a copy.

Go to the Send panel. Choose Cut Edge to
eliminate inner cut lines from the various layers.
Most of the time, this will work out so that no
inner shapes will cut and only the outline will cut.

Cut Edge only cuts the outside edge of
overlapping areas.
You can fix this a few ways. Go back to the
Design tab, and we’ll show you two ways to avoid
those inner cut lines even when your selection
is Cut Edge.
Option 1:
One way is to add an Offset to the design, and
then choose Cut Edge.

Turn on the registration marks, and let’s review
our Print & Cut checklist before sending the
design to print.
1.	
2.	
3.	
4.	

Page size set
Color
Registration marks on
Cut lines

The cut lines are on by default since this was a cut
file, but let’s see where they are in the Send panel.

However, you may end up occasionally with a
design like this where there is still a small portion
of the inner design that wants to cut.
Remember how we had that hole for the mouth
and nose when we first colored the bunny’s head?
That hole still wants to cut because it’s actually
a hole and not just a different colored piece on a
solid background.

This creates an offset background layer so no
holes are there to cut through.
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Option 2:
The second option is to make the mouth/nose
opening a separate piece and then color it.

You can choose which style you like best (with
offset or no offset) and make copies to fill your
page before printing.

Attach your cutouts onto something like a
small bag.

Ungroup until you can select and delete the
colored mouth/nose pieces.
Then right-click on the bunny head and choose
“Release compound path” so the hole for the
mouth/nose is released. (Add a line color to see
the shape that appears.) That piece has become
released as an opening and now is a separate layer.

Print the document and place it on your mat as
shown on screen. (Pay attention to the orientation
of the paper and where the registration marks are
in relation to the mat’s arrow.)
In the Send panel, choose the following:
f Material = Patterned Paper, or whatever
media you are using
Recolor just the nose/mouth pink, remove the line
color again, and Group all.

f Action = Cut
f Tool = AutoBlade (or other blade choice)

When you go to the Send panel again, choose Cut
Edge, and there will be no more inner cut lines.

Click Send when you’re ready.

That’s just one example of changing a cut file into
a Print & Cut design. We had to fill those colors
ourselves. Sometimes the pieces are already
colored for you, which we’ll explore next.
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How-to:
In Silhouette Studio®, we’ve opened a spaceship
design. This one is already in color, which is nice
for converting to a Print & Cut design.
Rearrange the pieces to look like the original
thumbnail image. This file is already in the correct
layer order, but use the Send Forward/Backward
options in the Quick Access Toolbar as necessary.

Lesson 3: Creating Custom Print & Cut Files
You can use the same process of turning a cut file into a Print & Cut design when you’re creating all or
most of the elements yourself from scratch.
Shapes and text created in Silhouette Studio® are cut files by default, but text lends itself especially well to
Print & Cut designs.
Let’s convert another cut file into a Print & Cut, and we’ll combine it with some other shapes and text to
create an invitation.

You can change the prefilled colors, if you want, by
selecting individual pieces and selecting a different
fill color.
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Now try adding shapes and text tools in
Silhouette Studio®, which are cut files by default.
We could simply draw a circle around this alien
and use it as a round sticker.

Turn on registration marks so we know where our
cut area is.

Resize the alien to fit the invitation and center
everything with the Quick Access Toolbar
align tools.

Now click the Text tool on the left, click down to
create a cursor, and type the details.

But let’s take this alien and step it up with some
text and other designs to turn it into an invitation.
In this example, we’ll open an invitation card kit
and use a set of coordinating shapes.
Ungroup and delete the extra pieces.
The background piece and the pocket envelope
will be cut from red colored paper (not Print &
Cut). We’ll use the smaller shape for the Print &
Cut invitation.
Select the text, and then change the font color, line
color, fonts, justification, and size as desired. You
can use the options on the Quick Access Toolbar
or in the Text Style panel.

Go ahead and set up the page size now in the Page
Setup panel. We’ll do letter size again and set it to
landscape orientation.

Now select the invitation piece and fill it with a
pattern. Send it to the back if it covers any of the
design you’ve already created.

Make any final changes and group the full design
together. Make a copy to fit two on the page. We’ll
use Print Bleed on this design, so let’s space them
a little farther apart.
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Print Bleed is a feature that became available with
Silhouette Studio® version 4.2. To turn on Print
Bleed, go to the Page Setup panel and check the
box for print bleed at the bottom.

Let’s look at another document where we have
an alien created a few different ways with clear
and white backgrounds. Here’s how it looks in
Silhouette Studio®.

With the print bleed turned on, the alien with a
clear background cut line and the alien as only its
original shape will bleed those colors.

Print Bleed Explained:
You won’t see the print bleed until you look at a
print preview or the actual printed page.
You should be aware that print bleed will affect
everything on your page, and that the background
color between your design and its cut line matters.
If you want print bleed to work, the colored design
must have a clear background.

The alien with a white background won’t bleed
the colors. If you want the white border around a
colored design, make sure to turn off print bleed or
make sure the design’s background color is white.
Back on our invitation, our page size is right, we
have registration marks on, and we have color, but
we need to adjust our cut lines in the Send panel
so all those letters inside don’t cut individually.

Print & Cut Perfection18

Go to the Send panel, select everything on the
page, and choose “Cut Edge.” This is an important
step whenever you’re adding text to a Print & Cut.

With the print preview, you can see a little
extension of the pattern paper, and you can see
that the colors are not going to run into each other
on the page.

Adhesive-backed cardstock is easy to apply to the
remainder of the invitation.

Finish printing your page.
Now load the printout onto the mat and into your
Silhouette cutter, and click Send.
Once it’s finished cutting, you can see how
that print bleed works. It extends the color so
there’s less chance of getting any white edges
when it cuts.
For this invitation, we’ll print it on printable
adhesive cardstock. Set it up as follows:
f Material = Cardstock, Printable
Adhesive Backed
f Action = Cut
f Tool = AutoBlade (or other blade choice)
Print. We recommend choosing print preview
on your printer settings whenever you have Print
Bleed enabled so you can see how that print bleed
is going to look.

Now you know how to turn cut files and text
into Print & Cut designs as well as how to use
print bleed to eliminate white edges when the
Silhouette machine cuts. Next, we’ll talk about
assigning cut lines to images that have no prior
cut lines.
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How-to:
We have a colored image on a white background,
and we want to add text and cut it out to turn it
into a temporary tattoo.
This is a PNG image that did not come from the
Silhouette Design Store, and it wasn’t created in
Silhouette Studio®, so it has no cut lines. (That’s
generally how image files like drawings and
photos come.)

Lesson 4: Creating Cut Lines from Traced Images
We’ve talked about using premade Print & Cut designs and also how to convert regular cut designs into
Print & Cut designs. Now we’re going to talk about turning images that have no cut lines into Print & Cut
designs. This involves the Trace feature in Silhouette Studio®.
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In the Send panel, it won’t matter which cut choice
you use; the design itself has no cut lines. You
may get a box around the design’s clear or white
background, but that’s not what we want.

“Trace” or “Trace Outer Edge” will create red cut
lines that immediately become visible. You should
generally group the cut line with each image.
All three of these Trace options create cut lines,
and that is one of the key requirements of a Print
& Cut design. Here’s how the designs look in
the Send tab.

If you drag the traced sunshine away, the
background is separate and can be deleted.

We need to Trace the design in order to assign cut
lines. We’ve made a couple of copies to review
Trace options.
f Open the Trace panel.
f Click on “Select Trace Area.”
f Drag a selection box around the image.
f Increase the threshold until all of the image
is filled with yellow or until at least the
outer edge is filled. Then choose “Trace
and Detach.”

For Tracing, you should know that “Trace” will
add holes to your design where it’s not filled with
yellow, and “Trace Outer Edge” will do exactly as
it sounds (ignoring unfilled areas in the middle).
These two choices will not remove the background
as the “Trace and Detach” option does.

Note: Depending on which version of
Silhouette Studio® you are using, “Trace and
Detach” may or may not automatically turn on
those cut lines. Check your Send panel when
you’ve used “Trace and Detach.” If the design
does not show cut lines, select it, and choose
“Cut” or “Cut Edge.”

Back in the Design tab, we’ll resize the traced and
detached sun smaller in order to Print & Cut a
whole page of these onto temporary tattoo paper
so that kids at school can wear them.
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Add text with the Text Tool, change the font and
size of the text to fit within the design, select
center justified for the alignment, fill the text
with black, remove the line color, center inside
the sunshine, nudge as necessary, and Group
all the elements together. (The order doesn’t
really matter.)

Before making copies, we’ll set the page size
to Letter, set the orientation to portrait, turn
on registration marks, and set cut lines in the
Send panel.
Sometimes your images will behave differently
depending on how they were created.

Zoom in to the design. If you select this whole
design and choose Cut Edge, only the outer edge
of the sunshine will cut. This is why we chose
“Trace and Detach” as our choice when tracing so
that we could eliminate any background as it’s
grouped with text.

If we add text and then choose Cut Edge on the
sun where we chose “Trace Outer Edge,” then
Silhouette Studio® wants to cut the original border.
We would have to ungroup, and then pick and
choose which cut lines to turn off or turn on. You
can still do this if you’ve created the cut line that
you want and need to turn certain areas off, but
that can be a little more tedious.

So we’ll stick with the version where we used
“Trace and Detach.” Go back to the Design tab and
make enough copies to fill the page. The Replicate
panel has a convenient Fill Page option, or use the
shortcut Ctrl + Shift + F or Cmd + Shift + F.

Mirror the designs (right-click + flip horizontally),
because that’s a requirement for temporary
tattoo paper.
You can use Print Bleed again if you want. We’ll
leave it off for this example.
Print the design onto white temporary tattoo
paper. Make sure you load the tattoo paper so it
prints on the glossy white side.
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In the Send panel, select the following:
f Material = Temporary Tattoo
Paper, Printable

2. Line up the exposed strip of adhesive with the
top of the printout and press it down to create
a hinge that keeps the adhesive in place while
removing the rest of the liner

f Action = Cut
f Tool = AutoBlade (or other blade choice)

Once the designs have been cut, the temporary
tattoos are ready to be applied to skin.
Peel off the clear protective layer from the
temporary tattoo, place the tattoo facedown
against the skin, moisten the paper backing with
a damp cloth, let it sit for 10–15 seconds, and then
remove the paper backing to reveal the colorful
temporary tattoo!

Once printed, attach the tattoo paper’s adhesive
layer onto the printout as follows:
1. Remove the top strip of backing

3. Carefully remove the adhesive layer’s liner by
pulling it away while smoothing the adhesive layer
down against the printout

Note: You could use white sticker paper
instead of temporary tattoo paper. In this case,
you would not mirror the design. Only mirror
the design if the media specifically instructs
you to do so.

Now you can place the tattoo paper on your
cutting mat as you see it on the screen and load it
into your Silhouette cutter.

Now you know how to create cut lines from image
files by Tracing.
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Print & Cut Troubleshooting
If your cuts are off from where they show in the Send panel, go through
these steps:
f Check your paper size and your cutting mat selection.
f Make sure you’ve turned on registration marks (see the note
regarding Type 1 or Type 2 in Lesson 1 if you are using a version of
Silhouette Studio® older than version 4.3).
f Make sure nothing on your printed page lies within the crosshatch areas.
For a “registration failed” message, try a manual registration. This process, and
more helpful troubleshooting tips, are in our YouTube version 4.1 how-to video
on Print & Cut Troubleshooting.
You can also check out the Silhouette Print & Cut FAQ or reach out to the
Silhouette support team if you need further help troubleshooting.

Conclusion
We hope you’ve learned a lot about Print & Cut in this eBook so you can
f Use premade Print & Cut designs.
f Convert shapes, text, and other designs into custom Print &
Cut projects.
f Trace images to convert them into Print & Cut designs.
Print & Cut really is a great feature, and you can use these techniques to
create unique projects with our wide variety of printable materials.
Find more uses and inspiration for Print & Cut as you visit the Silhouette 101
blog at Silhouette101.com.
As always, please reach out to Silhouette Support at SilhouetteAmerica.
com if you need further help.
Enjoy creating your projects in more color with Silhouette Print & Cut!

Designs Used:
Cute Watercolor Flower Bouquet | Design ID: 179524 | Page 6
Shadow Box Card Scene – Fall Bird | Design ID: 217701 | Page 6
Bunny Sunglasses | Design ID: 174526 | Page 11
Underwater Fish Paper | Design ID: 196324 | Page 12
Love You to the Moon – Alien Space Ship | Design ID: 246451 | Page 15
3 Invitation Card Kit | Design ID: 27841 | Page 16
Beachy Font | Design ID: 137774 | Page 16
LD Stock Font | Design ID: 8740 | Page 16
Sketch Circles Pattern | Design ID: 75043 | Page 16
Aunt Jana Font | Design ID: 12911 | Page 21

